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Abstract

Final Project aims to design and create Making Machine Model toll pass
automatically according to the type of vehicle that has ditentukan. Model
Making Machine Automatic Toll Card-Based Microcontroller ATmegal6
using weight sensor circuit, photodiode and infrared as Level sensors and
actuators such as DC motors . Block consists of an input process that
includes a sensor, then the process by ATMega microcontroller 16, and
actuation form of dc motors and gearbox. Setelah did Testing Model Making
Machine Automatic Toll Card, the machine can distinguish classes of
vehicles based on weight and height of the vehicle. Group vehicles can be
divided into five groups: group 1, group 2, group 3, group 4 and group 5.
Each group has a weight and height are different.

Keywords: Toll Card, Weight Sensors, Level Sensors, motor drivers,

ATmegal 6 Microcontroller.

Abstrak

Tugas Akhir bertujuan untuk merancang dan membuat model mesin
pengambilan kartu tanda masuk tol secara otomatis sesuai dengan jenis
kendaraan yang telah ditentukan. Model Mesin Pengambilan Kartu Tol
Otomatis Berbasis Mikrokontroler ATMegl6 ini menggunakan rangkaian
sensor berat, photodioda dan infrared sebagai sensor level dan aktuator
berupa motor DC. Blok proses terdiri dari input yang meliputi sensor,
kemudian proses oleh mikrokontroler ATMegal6, dan aktuasi berupa motor
dc dan gearbox. Setelah melakukan Pengujian Model Mesin Pengambilan
Kartu Tol Otomatis, mesin dapat membedakan golongan kendaraan
berdasarkan pada berat dan ketinggian kendaraan. Golongan kendaraan
dibedakan menjadi lima golongan yaitu golongan 1, golongan 2, golongan 3,
golongan 4 dan golongan 5. Tiap golongan memiliki berat dan tinggi yang
berbeda-beda.

Kata kunci : Kartu Tol, Sensor Berat, Sensor Level, Driver motor,

Mikrokontroler ATMegl6.
PENDAHULUAN
Kemajuan  dibidang  teknologi diciptakan. Perkembangan teknologi
terutama dibidang elektronika elektronika khususnya Otomasi dan
khususnya dibidang otomasi Kendali telah memebuat kualitas
memungkinkan untuk menciptakan kehidupan manusia semakin tinggi.
perangkat maupun mesin  yang Perkembangan teknologi telah mampu

mendukung kinerja manusia lebih
praktis atau sebagai alat bantu kerja
yang efisien yang kelak banyak
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meningkatkan kualitas maupun
kuantitas produksi berbagai bidang dan
aspek. Teknologi Otomasi dan Kendali
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juga telah menjangkau sisi hiburan dan
pendidikan bagi manusia.

Di kota-kota berkembang sangat
dibutuhkan suatu mobilitas yang tinggi
serta efisiensi dan efektifitas dalam
melakukan aktifitas sehari-hari,
dimana salah satu faktor penunjang
dari pada itu adalah akses jalan tol
yang lebih praktis dan cepat. Para
pengemudi pun menginginkan suatu
sistem pengambilan kartu tol yang
lebih efektif dan efisien, lebih praktis
dan jauh dari Human Error serta
mengantisipasi tindak kriminal pada
gerbang tol. Dalam hal ini kami
mencoba membuat suatu mesin yang
dapat membantu kinerja atau sistem
yang ada pada gerbang tol yang sudah
ada. Pada umumnya pintu tol untuk
pengambilan kartu dilakukan dengan
membagikan kartu tanda masuk tol
oleh petugas yang berjaga, namun
dalam  konsep mencoba mengganti
peran petugas penjaga menjadi suatu
mesin yang berkerja secara otomatis
untuk mengeluarkan kartu tersebut dan
mampu membedakan golongan jenis
kendaraaan. Model mesin Pengambil
Kartu Tol Otomatis ini berbasiskan
Mikrokontroler AVR ATMegal®6.

Jalan bebas hambatan atau sering
disebut jalan tol ternyata tidak
sepenuhnya terbebas dari hambatan.
Kemacetan yang terjadi pada jalan tol
sebagian besar diakibatkan oleh sistem
pengambilan kartu/tiket tol yang masih
konvensional. = Kemacetan  dapat
dikurangi, bahkan bukan tidak
mungkin untuk dihilangkan. Dengan
pengambilan kartu tol otomatis yang
berfungsi untuk mengurangi
kemacetan yang sering terjadi tiap
gerbang tol yang masih menggunakan
metode konvensional yang masih
menggunakan petugas untuk memberi
tiket atau kartu pada tiap kendaraan,

dikarenakan =~ masih  menggunakan
petugas maka metode itu masih belum
mencapai titik maksimal.

Berdasarkan pemikiran diatas pada
penelitihan dituntut mencoba
merancang suatu sistem kerja mesin
yang dapat mengeluarkan kartu tanda
masuk tol dengan membedakan
golongan kendaraan dan menampilkan
berapa besar biaya di layar LCD yang
akan dibayar pada gerbang tol
berikutnya, dengan berbasi
Microkontroler =~ AVR  ATMegal6
menggunakan sensor berat (Load Cell)
dan sensor level, yaitu Infrared dan
Photodiode.

METODE

“Model Mesin Pengambilan Kartu
Tol Mikrokontroler AVR ATMegal6”
adalah mesin untuk pengambilan kartu
tol otomatis dengan menggunakan
sensor  level untuk  mengetahui
golongan apa yang sesuai dengan
kendaraan tersebut. Mesin akan aktif
ketika kendaran memberikan beban
kepada sensor berat dan menghalangi
sensor /evel pada gerbang tol tersebut
dan kartu tol akan keluar dengan
indikator lampu  sesuai  dengan
golongan kendaraan yang telah
ditentukan secara otomatis. Sensor
yang di pasang pada gerbang tol
tersebut berguna untuk mengetahui
level dan berat, serta membedakan
golongan kendaraan dengan indikator.

Pembuatan  perangkat mekanik
terdiri atas  perencanaan  desain
mekanis yang mendukung kerja sistem

mesin  sesuai  dengan  fungsinya.
Perencanaan terdiri dari desain
pembuatan mekanik untuk

mengeluarkan kartu dan indikator-

indikator golongan kendaraan.
Sedangkan pada pembuatan

perangkat keras elektronik terdiri dari



pembuatan rangkaian sensor, sistem
minimum mikrokontroler ATMegal6
sebagai pusat pengontrol penggerakan
mesin yang utama, driver penggerak
motor DC sebagai aktuator pergerakan
mesin.

Diagram Blok
POWER SUPPLY

LCD

SENSOR
BERAT

LAMPY OO
1)

SENSOR
LEVEL

MOTOR 1
(PALANG)

MIKROKONTROLER |
AT MEGA 16

MOTOR 2
(KARTL)

LAMPL
MIERAN & DAL

Gambar 1. Blok Diagram Alat

Gambar 1 merupakan blok diagram
alat yang dimana Power Supply
mengalir ke Sensor Berat, Sensor
Level, Mikrokontroler ATMega 16,
LCD, Lampu Indikator 1-5, Motor 1,
Motor 2, dan Lampu Merah dan Hijau.
Sensor Berat dan Sensor Level
merupaka input yang masuk ke
Mikrokontroler ATMega 16 dan
sebagai outputnya yaitu : LCD, Lampu
Indikator 1-5, Motor 1, Motor 2, dan

Lampu Merah dan Hijau.
Pembuatan Model = Mesin
Pengambilan Kartu Tol Otomatis

dilakukan dalam beberapa tahapan.
Tahap pertama 1alah pembuatan
hardware yang terdiri atas pembuatan
mekanik  Mesin, dan pembuatan
rangkaian kontrol. Pada tahap kedua
dilakukan perancangan sofiware yang
terdiri atas penentuan port yang akan
digunakan, program untuk
mikrokontroler ~ yang  digunakan,
pembuatan  program serta tahap
terakhir yakni pengujian alat.
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Rangkaian input dari Model Mesin
Pengambilan Kartu Tol
Otomatisberupa sensor. Jenis sensor
yang digunakan adalah  Sensor
Berat,photodioda  dan Infrared,
dimana sensor akan membaca jenis
kendaraan sesuai dengan berat dan
tinggi kendaraan yang telah di
tentukan. Rangkaian pemroses
menggunakan mikrokontroler AVR
ATMega 16 serta Rangkaian output
menggunakan driver 1293D untuk
Motor untuk menghasilkan putaran
motor DC sebagai penggerak motor
untuk mengeluarkan kartu tanda
masuk tol dari dalam mesin, dan
motor untuk penggerak palang pintu
tol.

Pembuatan Hardware

Dalam perancangan alat yang perlu
diperhatikan  adalah  mulai  dari
pemilihan bahan untuk maket, desain
konstruksi tiap bangun, mekanik yang
digunakan untuk menekan sensor
berat, dan ketepatan pemasangan
tempat sensor berat dan sensor /level.
Kartu yang keluar didorong oleh motor
DC/motor  gearbox yang sudah
disesuaikan untuk menggeser kartu
agar jatuh ke tempat pengambilan.

Pembuatan Mekanik Mesin

Pembuatan maket Model
Pengambilan kartu tol otomatis
menggunakan bahan dasar acrylic
setebal 3mm yang berfungsi sebagai
maket untuk mesin. Acrylic tersebut
dapat  dibentuk  sesuai  dengan
keinginan. Acrylic tersebut cukup
ringan untuk menopang motor gearbox
serta motor DC yang digunakan untuk
sebagai palang. Gambar 2
menunjukkan bentuk design dari
model alat.

Blok maket dan mekanik dibagi
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menjadi 6 bagian, yaitu :

Box panel

Box palang

Box kartu

Box lampu indikator

Tempat sensor /evel

Tempat sensor Berat/flexiforce

AN

Gambar 2. Rancangan Design Mesin

Pembuatan Rangkaian Elektrik
Rangkaian elektrik yang digunakan
Model Mesin Pengambilan Kartu Tol
Otomatis terdiri  rangkaian input,
rangkaian pemroses dan rangkaian
output.  Pada  rangkaian  input
menggunakan sensor pembaca jenis
kendaraan sesuai dengan berat dan
level/ketinggian kendaraan yang telah

ditentukan.  Rangkaian  pemroses
menggunakan sistem minimum
mikrokontroler = AVR  ATMegal6,

sedangkan pada rangkaian output
menggunakan rangkaian driver
sebagai penggerak motor dan lampu
indikator.

Pembuatan Sensor

Rangkaian sensor yang digunakan
untuk sensor level atau ketinggian
menggunakan sensor infrared dan

photodioda.  LedInfrared  sebagai
pemancar (transmitter) dan
photodioda sebagai penerima
(receiver). Rangkaian sensor di

gunakan untuk sensor garis pada jalur
mesin, sebagai sensor jarak apabila
mesin telah sampai pada letak objek,

dan sebagai sensor pendeteksi adanya
barang. Gambar 3 menunjukkan skema

rangkaian sensor menggunakan
infrared.
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Gambar 3. Rangkaian Sensor Leve/

Pembuatan Driver

Rangkaian driver motor yang
menggunakan IC L293D difungsikan
sebagai pengendali. Kendali yang
dilakukan IC L293D adalah untuk
mengerakkan motor yang berfungsi
sebagai penahan dan pendorong kartu
agar dapat keluar. Tegangan input yang
diperlukan driver motor antara 4,5 V-
36 V. Input pada IC L293D yang

diterima  berasal dari rangkaian
pemroses yakni sistem minimum
mikrokontroler  yang  sebelumnya

berasal dari rangkaian sensor.

Driver  juga digunakan untuk
menggerakkan motor DC  yang
berfungsi  untuk  menutup dan

membuka palang gerbang tol. Gambar
4 menunjukkan rangkaian driver dan
fungsi tiap kakinya.

........

Gambar4. Rangkaian Driver Motor
Pembuatan Sismin

Sistem minimum (sismin)
mikrokontroler  adalah  rangkaian
elektronik minimum yang diperlukan



untuk beroperasinya IC
mikrokontroler. Sismin kemudian bisa
dihubungkan dengan rangkaian lain
untuk menjalankan fungsi tertentu.

R I,

P

Gambar 5. Sistem Minimum AVR
ATMegal6

Penentuan port yang akan dipakai
sangat penting sebelum membuat
program, yang bertujuan sebagai
masukan dari sensor dan keluaran
untuk penggerak atau Motor DC.
Jumlah port yang dipakai pada
mikrokontroler ATMegal6 sebanyak 4
port, berikut adalah port-port yang
digunakan:

PORT A

Pada Port A digunakan sebagai
masukan dari sensor FLEXIFORCE
atau sensor berat dan motor gearbox
yang berfungsi sebagai palang serta
mekanik yang berfungsi mengeluarkan
kartu. Keluaran sensor flexi force pada
Port A menjadi input mikrokontroler
yang berlogika high, dan selanjutnya
mikrokontroler akan melakukan proses
seperti program yang telah dibuat.

Tabel 1. Penentuan Port Mikrokontroler
Pada port A
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PORT A KET.

PORT A.0 Sensor Flexi Force

PORT A1 Sensor Flexi Force

PORT A2 Motor gearbox maju

PORT A3 Motor gearbox mundur

PORT A4 Mekanik CD maju

PORT A5 Mekanik CD mundur
PORT B

Pada Port digunakan sebagai

masukan  dari  sensor infrared
photodioda. Keluaran sensor pada port
B menjadi input mikrokontroler yang
berlogika  high, dan selanjutnya
mikrokontroler akan melakukan proses
seperti program yang telah dibuat.

Tabel 2. Penentuan Port
Mikrokontroler Pada port B

PORTB KET.

Port B.O Sensor 1
Port B.1 Sensor 2
Port B.2 Sensor 3
Port B.3 Sensor 4
Port B.4 Sensor 5
Port B.5 Sensor 6

PORT C

Pada port C digunakan untuk LCD
(Liquid Crystal Display).

PORT D

Port D digunakan untuk lampu
indikator golongan kendaraan dan
lampu indikator merah dan hijau.

Tabel 3. Penentuan Port
Mikrokontroler Pada Port D

PORT KET.
PortD.O Indikator 1
Port D.1 Indikator 2
PortD.2 Indikator 3
PortD.3 Indikator 4
PortD.4 Indikator 5
PortD.5 Indikator Merah
Port D.6 Indikator Hijau
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Pembuatan Power Supply

Power supply yang digunakan
yakni dengan memakai IC 7805. IC
7805 berfungsi memberikan sumber
tegangan pada tiap rangkaian sebesar
+5  Volt, namun tegangan yang
diberikan dari sumber asli tidak
sebesar ~ +5Volt.  Untuk  dapat
menurunkan tegangan yang terdapat
pada  supply, maka  dibutuhkan
rangkaian-rangkaian penurun
tegangan. Salah satunya adalah IC
7805 (Linear Voltage Regulator).
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Gambar 6. Linear Voltage Regulator
L7805
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Gambar 7. Rangkaian Power Supply

Rangkaian LCD

LCD yang digunakan adalah tipe
LMBI162 dengan tampilan 16 x 2
karakter. Dari gambar dapat dilihat
pin-pin LCD dihubungkan dengan
Port C dari mikrokontroler AVR
ATMegal6, untuk dapat menampilkan
teks. Gambar 8  menunjukkan
rangkaian skematik LCD.

LCD 16x2 Karakter

w55 WCC VEE RS RW E DBS0 D81 DEZDB3DB4 DES D36 DBT A K
PR FEZ
+5W

S IIE

+5W
Gambar 87 Rangkaian Skematik LCD

Pengaplikasian Software

Pembuatan Model Mesin
Pengambilan Kartu Tol Otomatis
berbasis Mikrokontroler AVR
ATMegal6, selain terdapat rangkaian
berupa input dan output, terdapat juga
sebuah proses yang memberi perintah
pada setiap gerakan, proses tersebut
diatur  oleh  program.  Bahasa
pemrograman yang digunakan adalah
bahasa C yang dibangun melalui
software Code Vison AVR yang
kemudian didownload melalui AVR
ISP Programmer Cable.

Code Vision AVR ATMegal6
Code Vision AVR C Compiler pada

dasarnya merupakan perangkat lunak
pemrograman mikrokontroler keluarga
AVR berbasis bahasa C. Ada tiga
komponen  penting yang telah
diintegrasikan dalam perangkat lunak:
Compiler C, IDE dan Program
Generator. Pada tool Code Vision AVR
bisa  ditentukan  port-port  dari
Mikrokontroler AVR yang berfungsi
sebagai input maupun output, serta
bisa  juga  ditentukan  tentang
penggunaan fungsi-fungsi internal dari
AVR. Dalam program terdapat sebuah
pemroses yang akan memerintahkan
setiap pergerakan aksi mesin dengan
pemrograman bahasa C. Adapun
langkah-langkah dalam pembuatan
program, Gambar 9 menunjukkan
bentuk frame file type.

1. Jalankan Code Vision AVR,
kemudian klik File->New, Pilih
Project.

B e
File Type
i+ Sowce

- Project

Gambar 9. File Type
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“Do you want to use the Code
WizardAVR?” Klik Yes.

Pilih Chip yang digunakan, chip:
ATmegalb, clock 12. OOOOOO MHZ

[@* Codewizar.

File Help
USART | Anslog Comparator | ADc | P10 |
12c 1 1 Wire 2%ire 1203 |
LCD Bit-Banged |  Proisct information |
Chip Forts | Ewmemal 1RO | Timers

Chip: [almegausss = |

Chock: [12 OO0000 =] b=

T Check Boset Souwice
Frogram 1 upe:
| Suppsticaatinar e =1

Gambar 10. Code Wizard AVR untuk
Penggunaan Chip

4. Lakukan setting sebagai berikut:

hd

Port A= Sebagai Input Pullup
Port C = Sebaga1 Output

[ codwvwicar..

uz-:glxuggs
arrprpat
2
i
i

BF cCodeWizar... e i .
File Help
USART | Analeg Comparatar | ADC | SPI
(P | 1 whie | 2 e (1200)
LD | BitBanged | Proiect Information
Chip [ Fois 1] Esternal RO | Timers

Pota | Pone PorC | o]
Data Direction Fuilluap A0 itk W sl

Bit 0 DOt 1] BRO
Bit 1 Ol 1| B
Bit 2 Out 1| B2
Bit3 Ou| 1| B3
Bitd Ouw| 1| B 4
Bit 5 Ous| 1) Bts
Bit B Out 1| Bre
Bit 7 Ou| 1| B 7

Gambar 11. Code Wizard AVR untuk
Penentuan Port

Gambar 11 menunjukkan menu
untuk menentukan port yang
digunakan sebagai inmput atau
output.

Klik File->Generate, Saveand Exit.
Buatlah source code seperti pada
lampiran.

7. Setelah selesai membuat source
code, klik Setting->Programmer.

8. Pilih AVR Chip Programmer Type:
Ganda System STK200+/300 dan
pilih Printer Port pada LPT1:378h

9. Klik Project ->Configure,
kemudian pilih menu After Make
dan aktifkan Program the Chip.
Klik OK jika sudah.

’a‘;{ Configure Project TA.prj

Files | CCampier  Adter Make |

I Program the Chip I Executs Users Progiam

T e data B & FOM Filis for FLASH Programmiog

Chip Frogramming Dpticns
| FLASH Lock Bits Fuso Btz

= o et
 Programming disabled . cepel i
T Piogremiing end ericlion dssbled e

: [ B0DER-0

~BockLock Bit 06— ~Boct Lack Bit1— |[] BODLEVEL=0
* B=1R0z=1 & OB =1R12=1 F EEJEIE\;‘;I-}?
B =0 B02=1 © Bi1=0B12=1 o
BN -0 Bl2-0  BN-0E12-0 Craer-o.

| Bme1Bozn | | BN=1B12:0 | Sasaenen

¥ Check Siopature ¥ Check Erature [ Praserve EEPROM ' Yedy

X cows | P B |

Gambar 12. Konfigurasi Chip

Gambar 12 menunjukkan menu
untuk menentukkan jenis chip yang
digunakan.

10.Untuk meng-compile project, klik
Project ->Make. Pastikan program

tidak ada yang error.
r0 Information | ————
I Compler lﬁuurblell Frogeommes |

Chip ATmegat535

Frogram bype: &ppicabon
Memony model Smal

Opbmize fon: See

[siprinlf features: ink vadth
[s}sart festues: ik widih
Fromobe char bo ink: He

char is ursigred. Yes

& bl enums; es

Enhanced core matrechions: On
Automalic regster aliocaton On

226 inez] compiled

Mo ermars

Mo wamings

Bit wanshles size: 0 bybe[s)

Date Stack ares: 60k b BFh

D1t Stack sive: 120 bylels|
Estimated Dala Stack wsage: 0 bylefs]
Glabal veriables sme 0 byles)

Hancware Stack areal ECh o 25Fh
Herdweare Stack size: 364 bpbels|

Heap size: 0 bybels)

EEFADM uzage: 0 bybels) (0% of EEPAOM)
Frogram size: 111 words [2 7% of FLASH|

e
Gambar 13. Tampilan Compiler
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Gambar 13.menunjukkan proses
flashing program kedalam
mikrokontroler.

11. Jika tidak ada error maka file siap
didownload ke chip. Pastikan
koneksi kabel downloader dan chip
sudah terpasang dengan benar, klik
Tools -> Chip Programmers.

!’Q CodeVisionAVR Chip Programmer. ..
IFiIa Edit Program Read Compare Help

e |~ |
FLASH EEFROM-

sl kb End[EE  h| (Saed b Ent[iFF h
Checksunc 0000k

A% Pegansl] (B Regst Chip

Checkzum: S430k

Chip Programming Opticns
FLASH Lock Bits Fuze Billsh
& ; TRSELD=N
Hg Prolection - sEL1-0
" Piogiamming deabled LERE 2ot

 Programming and Yerification disabled

Bocet Loz Bir

Eoot Lock Bit 1
‘ & B01-1B02-1

@ en-a1z-1 | |- So0T e
© g11-081240 | | CROPT-0
[\ Br= przn| |5 SRIEND

@
=]
g
o
@

" BO1-0B02-1
" BO=0B02-0
" Bli=1 BOZ=0

¥ Chack Sigyahue ¥ Check Erasure [ Frasaie EEFROM [ Yerly

Gambar 14. Menunjukkan proses
mendownload program
ke mikrokontroler.

12.Nyalakan power supply dan klik
Program All. Tunggu hingga proses
download selesai.

Perancangan Program

Program yang digunakan sebagai
pemrograman bekerjanya mesin Model
Mesin  Pengambilan  Kartu  Tol
Otomatis  berbasis  Mikrokontroler
AVR ATMegal6 ialah Code Vision
AVR. Proses pembuatan program
tersebut terdiri atas :

Inisialisasi Program

Inisialisasi ialah bagian yang
terdapat pada program utama yang
berfungsi untuk melakukan persiapan
penggunaan port-port. Dimana port-
port yang akan dipakai dikoneksikan
pada program yang dibuat dapat
menggerakkan suatu sistem yang

dirancang untuk penginisialisasian
port masukan dan port keluaran.

Pada tahap inisialisasi, alamat awal
yang digunakan adalah FFh. Jumlah
port yang digunakan sebanyak dua
port. alamat pada port dituliskan
alamat tertinggi, dikarenakan port
tersebut active high. Begitu juga
sebaliknya, alamat pada port dituliskan
alamat terendah, maka port tersebut
active low.

Program Utama

Program utama adalah program
keseluruhan mesin yang didalamnya
terdapat program agar motor dapat
bergerak. Untuk program keseluruhan,
dapat dilihat pada lembar lampiran.

Spesifikasi Alat

Model Mesin Pengambilan Kartu
Tol Otomatis dirancang untuk dapat
melaksanakan  fungsi-fungsi sesuai
dengan algoritma yang mengeluarkan
kartu sesuai dengan jenis kendaraan
dan golongannya. Dalam pembuatan
Model Mesin Pengambilan Kartu Tol
Otomatis, hal yang perlu diperhatikan
adalah penempatan sensor, desain
konstruksi, sistem mekanik, dan
pemasangan gearbox pada mesin,
sehingga kartu akan keluar dengan
baik.

Pada Tugas Akhir pembuatan
Model Mesin Pengambilan Kartu Tol
Otomatis, kerangka mesin terbuat dari
bahan acrylic (3mm). Mekanisme
untuk mengeluarkan kartu, digunakan
motor DC yang berasal dari mekanik
CD dan gearbox 12 Volt untuk
menggerakkan palang. Mekanik CD
yang sudah disambungkan dengan
motor DC berfungsi untuk mendorong
kartu keluar, mekanik pendorong yang
sudah  disambungkan ke motor
mekanik  CD  berfungsi  menjadi



pendorong untuk mengeluarkan kartu
ke lubang yang telah ditentukan.

Pada Model Mesin Pengambilan
Kartu Tol Otomatis, dipasang 5 sensor
photodioda  sebagai sensor [level
pembaca ketinggian kendaraan dan 1
sensor lagi sebagai penggerak palang.
Peletakkan sensor [level, diletakkan
berderet dan menyusun keatas, dengan
jarak antara sensor yang lainnya 3 cm.
Pemasangan sensor dilakukan agar
kerja sensor dapat bekerja dengan baik
sesuai dengan tinggi kendaraan yang
telah ditentukan. Sensor berat di
dibuatkan mekanik khusus agar dapat
tertekan oleh beban. Pada bagian
depan mesin terdapat 1 sensor sebagai
indikator  untuk  menutup  dan
membuka palang serta driver untuk
lampu indikator.

HASIL DAN PEMBAHASAN
Pengujian alat dilakukan untuk
mengetahui seberapa besar nilai yang
dihasilkan, yakni berupa tegangan dari
sensor berat, sensor level dan output
IC L293D serta rangkaian sistem
minimum.Instrumen yang digunakan
untuk mengukur tegangan adalah
dengan  menggunakan  multimeter
analog serta multimeter digital.
Pengujian alat dilakukan dengan
cara  mengukur  tiap-tiap  titik
komponen yang terjadi perubahan
tegangan karena aktif atau tidaknya
suatu rangkaian. Alat yang digunakan
dalam pengukuran tegangan dan arus
pada tiap-tiap titik adalah multimeter
digital merk Sanwa CD800A dan
multimeter analog Heles SP-38D
dengan spesifikasi: DCV = 0.25-2.5-
10-50-250-500-1KV + 3% FS 4 KQ/V,
ACV = 10-50-250-500-1KV =+ 5% FS
4KQ/V, DCA = 0.25-25-500mA + 3%
FS<0,4V,Q=X1, X10-X1K + 3 FS,
BATT = 0,8 - 1.6V. Nethook dengan
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spesifikasi Prosesor Intel Arom Inside
N550.Program bantu berupa AVR
Code Vision versi V2.05
Instrumen yang digunakan
Multimeter adalah suatu alat yang
dipakai untuk menguji atau mengukur
komponen disebut juga Avometer,
dapat dipakai untuk mengukur ampere,
volt dan ohm meter. Multimeter digital
mempunyai keunggulan, karena nilai
yang dihasilkan melalui multimeter
digital lebih akurat serta mudah dalam
pembacaan. Pada pengukuran alat
tersebut, rangkaian yang diukur
menggunakan  multimeter  adalah
rangkaian sensor level, sensor berat
dan driver.

Rangkaian Input

Rangkaian input yang akan diuji
adalah rangkaian sensor /level dan
sensor berat.
Pengukuran Sensor
Level

Pengukuran dilakukan pada input
IC LM339, pengukuran dilakukan
pada dua kondisi yaitu pada saat
sensor terhalang kendaraan dan pada
saat tidak terhalang. Apabila sensor
terhalang kendaraan maka nilai yang
dihasilkan berlogika rendah.
Sebaliknya, jika sensor tidak terhalang
maka nilai yang dihasilkan akan
berlogika tinggi.

Rangkaian
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Gambar 15." .éi;ema dan susunan
peralatan untuk pengujian
blok rangkaian sensor
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Pengukuran sensor berat

Pengukuran dilakukan pada dua
kondisi yaitu pada saat sensor diberi
beban dan pada saat tidak diberi beban.
Apabila sensor diberi beban maka nilai
yang  dihasilkan  berlogika 1.
Sebaliknya, jika sensor tidak diberi
beban maka nilai yang dihasilkan akan
berlogika 0.

Nilai ADC =

Keterangan :

1. Nilai range ADC tiap golongan
yang tampil pada LCD dengan
bilangan (Desimal).

2. Nilai ADC yang ditetapkan untuk
(Golongan 1) = >0 < 75. Dengan
Beban Benda =1 Kg.

3. Nilai ADC yang ditetapkan untuk
(Golongan 2) => 76 < 130. Dengan
Beban Benda = 2 Kg.

4. Nilai ADC yang ditetapkan untuk
(Golongan 3) = > 131 < 170.
Dengan Beban Benda = 3 Kg.

5. Nilai ADC yang ditetapkan untuk
(Golongan 4)=> 171 < 193.
Dengan Beban Benda =4 Kg.

6. Nilai ADC yang ditetapkan untuk
(Golongan 5)=> 194 < 255.
Dengan Beban Benda = 5 Kg

Vin

VReff

x 255

Rangkaian proses

Rangkaian proses terletak pada
rangkaian sistem minimum. Nilai yang
diukur adalah keluaran dari
mikrokontroler, yang terdapat pada
port.

Pengukuran Rangkaian Proses
Pengukuran  rangkaian  proses
dilakukan untuk dapat mengetahui
nilai tegangan yang dihasilkan pada
port dari mikrokontroler. Diukur untuk
input yang ada pada port A dan output
pada port B dan D. Pengukuran
dilakukan untuk mengetahui nilai

tegangan yang dihasilkan pada port A,
B dan D yang berlogika tegangan high
atau low.

Tabel4. Pengukuran rangkaian proses

Input logika High portA
Tegangan mput berlogika Ket.
high
6 Sensor 1
6 Sensor 2
6 Sensor 3
6 Sensor 4
6 Sensor 5
6 Sensor 6
Tabel 4  menunjukkan  hasil

pengukuran pada rangkaian proses
input yang dilakukan pada port A.

Tabel 5. Pengukuran Rangkaian Proses
Input Logika Low Pada PortA

Tegangan input berlogika low Ket.

Sensor 1

Sensor 2

Sensor 3

Sensor 4

Sensor 5

Sensor 6

Tabel 5 menunjukkan  hasil
pengukuran pada rangkaian proses
input logika low yang dilakukan pada
port A.

Tabel 6. Pengukuran Rangkaian Proses
Output Logika High Pada Port B

Tegangan input berlogika low Ket.

Indikator 1



Indikator 2

Indikator 3

Indikator 4

Indikator 5

Indikator

7 Merah
Indikator

7 Hijau

Tabel 6  menunjukkan  hasil
pengukuran pada rangkaian proses
output logika high yang dilakukan
pada port B.

Tabel 7. Pengukuran Rangkaian Proses

Output Logika LowPortB
Tegangan input berlogika
low Kete.

Indikator 1
Indikator 2
Indikator 3
Indikator 4
Indikator 5

Indikator
Merah
Indikator Hijau

Tabel 7 menunjukkan  hasil
pengukuran pada rangkaian proses
output logika low yang dilakukan pada
port B.

Tabel 8. Pengukuran Proses Output

Logika Low Pada Port D
Tegangan input berlogika
low Ket.

7 65 4 3 2 1 0

0 Indikator 1
0 Indikator 2
0 Indikator 3
0 Indikator 4
0 Indikator 5
Indikator

Merah
0 Indikator
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Hijau

Tabel 8. Menunjukkan hasil
pengukuran pada Rangkaian Proses
Output logika Low yang dilakukan
pada Port D.

Tabel 9. Pengukuran Proses Output

Logika HighPada Port D
Tegangan input berlogika
low Keteranga

7 6 5 4 3 2 1 0 n

4,7 Indikator 1
4.7 Indikator 2
4,7 Indikator 3
4.7 Indikator 4
4,7 Indikator 5
Indikator
Merah
Indikator
Hijau

4,7

4,7

Rangkaian Output

Pengukuranoutput dilakukan pada
inputlC L293D dan output 1C L293D.
Pengukuran dilakukan saat input atau
output berkondisikan Aigh (1) dan low
(0). Tegangan yang diberikan untuk
motor ialah sebesar +12V  dan
tegangan untuk IC L293D adalah
sebesar +5V.

Tabel 10. Pengukuran output 1C

L293D
Kondisi

Output 1.293D W

)] (0)
Motor gearbox buka 9 0,6
Motor gearbox tutup 9 0,6
Mekanik CD maju 9 0,6
Mekanik CD mundur 9 0,6

Hasil Analisa Sistem

Tahap pengujian analisa sistem
dapat  dilakukan = dengan  cara
melakukan pengujian melalui program.



M. Ridho Januady., dkk, Model Mesin Pengambilan Kartu Tol... | 21

Pengujian dilakukan dengan tujuan
agar dapat diketahui apakah sistem
mekanik mesin yang dibuat telah
melakukan fungsinya dengan benar
sesuai dengan apa yang telah
diprogram. Mesin dapat memberikan
indikasi  kartu  sesuai  golongan
kendaraan dan menentukan golongan
kendaraan berdasarkan pada Berat dan
Tinggi Kendaraan.

Implementasi Alat
Hasil penelitian diharapkan
mempunyai implementasi pada

beberapa bidang, yaitu:

Bidang Keteknikan

Penelitian pembuatan Model Mesin
Pengambilan Kartu Tol Otomatis
diharapkan dapat dijadikan sebagai
aplikasi nyata dari kemajuan teknologi
kendali secara otomatis menggunakan
Mikrokontroler.

Bidang Transportasi

Pembuatan Model Mesin
Pengambilan kartu tol otomatis
diharapkan dapat dikembangkan untuk
membantu proses transaksi dalam
gerbang tol agar lebih efektif dan
efesien.

Bidang Pendidikan

Sistem Model Mesin Pengambilan
kartu tol otomatis diharapkan dapat
dipelajari dan dapat dipraktikkan
sebagai alat bantu pembelajaran, serta
dapat memberikan sumbangan ilmu
pengetahuan meski khususnya aplikasi
Mikrokontroler guna menjadi salah
satu acuan bagi para pengembang
sesudahnya yang berkeinginan
mengembangkan sistem mesin dan
mikrokontroler.

KESIMPULAN DAN SARAN

Kesimpulan
Setelah melakukan penelitian pada

Model Mesin Pengambilan Kartu Tol

Otomatis  berbasis = Mikrokontroler

AVR  Atmegal6, maka  dapat

mengambil kesimpulan dari hasil

pengujian sebagai berikut:

1. Model Mesin dapat memberikan
indikasi ~ golongan  kendaraan
berupa lampu indikator sesuai
golongannya masing-masing

2. Model mesin dapat membedakan
golongan kendaraan berdasarkan
pada berat dan tinggi kendaraan
yang telah ditentukan.

Saran

Dari hasil penyusunan proposal
penelitian dan  juga pembuatan
terhadap Model Mesin Pengembilan
Kartu Tol  Otomatis  berbasis
Mikrokontroler =~ AVR  ATMegal6,
masih terdapat banyak kekurangan,
baik dari segi sistem mekanik mesin,
elektronik maupun insialisasi program.
Maka, terdapat beberapa saran serta
masukan, agar  dalam  proses
pengerjaan Tugas Akhir nantinya akan
dapat lebih baik lagi. Berikut saran dan
masukan diantaranya:

1. Kemungkinan adanya kekurangan
yakni pada bagian mekanik mesin,
dimana mekanisme cara motor
untuk mengeluarkan kartu.

2. Memaksimalkan penggunaan port
yang ada pada mikrokontroler AVR
ATMegal6 agar dapat
memaksimalkan kerja mesin sesuai
aplikasi yang digunakan.

3. Penyusunan program yang baik dan
benar sehingga mesin dapat bekerja
sesuai dengan yang diharapkan.
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